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Understanding the User Interface

In this Chapter, we'll talk in more depth about the many aspects of REMIX's
interface. You'll learn about the details of each of the Views and the many
editing operations you can perform in them.

The Control Bar
EMOOOENDE  EEECOENE] koo

The Control Bar.

The Control Bar is the centralized location for a number of important func-
tions in REMIX. It also contains a number of indicators to give certain vital
bits of information while a REMIX Set is running.

Tempo and Time Signature

4000/ % 14

The tempo and signature fields.

The far left field of the Control Bar is where you will set the tempo for your
REMIX Set. You can change the tempo by clicking and dragging up or
down on the tempo field, or by double-clicking in the field and typing in a
value.

To the right of the tempo field is the time signature control. You can use this
to specify the number of beats per bar and the length of a beat. To achieve
waltz time, for example, you would set the time signature to 3/4. You can en-
ter this value by clicking and dragging or by typing it into the field.

Transport

The Transport controls.

The Transport controls can be seen as roughly analogous to those of the fa-
miliar tape machine.

The Song Position indicator lets you know where you are in the REMIX Ar-
rangement by supplying you with bar, beat, and 16th note values.
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You can also click and drag on the Song Position field or type a value di-
rectly into it to go to any point in the Arrangement.

The Play, Stop, and Record buttons work just like the corresponding but-
tons on a tape recorder. You can click the Record button at any point while
REMIX is playing to begin recording automation and triggered clips into the
Arrangement.

The button with an arrow pointing to a symbolised Arrangement is the so
called Return-to-Arrangement button. It lights up as soon as you deviate
from the Arrangement, for instance by playing a clip from the Session View.
REMIX will suspend Arrangement playback for the track that contains the
launched clip until you click the Return-to-Arrangement button. Likewise,
when you change the value of an automated control, REMIX temporarily de-
couples this control from the Arrangement, until you Return-to-Arrangement.

The pop-up menu allows you to set the quantization rate for clip triggering.
This guarantees that a clip will fire on the beat. You can set quantization val-
ues between none and 1/32 note, depending on your rhythmic accuracy.

When “Use Global Quantization” is checked in the Options menu, the glo-
bal quantization setting can also be used for editing in the Arranger and in
the Clip View. The global quantization can also be set using the Options
menu with keyboard commands being available for all values.

Loop Parameters

The Loop Indicator.

The Loop Indicator section of the Control Bar allows you to turn the Loop
function on and shows the boundaries of the current loop position. The left-
most display shows the beginning of the loop and the rightmost display
shows the length. Click on the button labeled Loop to turn looping on and
off. It will light up to let you know that it is on. You can type values into the
loop start and length fields or you can click and drag to set new values.
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System Monitor

The Key map switch and System Monitor.

The monitor bar measures CPU load with a meter display and displays the
respective percentage value. The hard drive overload indicator (“D") lights
up when REMIX is unable to stream audio from the hard drive in time.

The Key Map mode switch is used to switch Key Map mode on or off. When
this mode is activated, you can assign clip slots or scene buttons to keys on
your computer keyboard and then control them using those keys. Find more
details on page 25 in the Quick Start Guide.

The Session View
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The Session View.

The Session View will probably be your main area of focus during the per-
formance of a REMIX Set. It contains the clip tracks and send tracks, the
mixer controls, and an overview of the Arrangement, among other things.
Using the Session View, you will be able to trigger and stop clips, and mix
them on the fly as part of your performance or improvisation. You can also
make the Send settings here.

Let us break down the individual components of the Session View:
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The Overview
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The Overview, showing an Arrangement.

The Overview shows you a miniaturized bird's-eye view of the Arrangement.
You can use it to see the progress and arrangement of clips as you record.

The current position is marked by a thin vertical line that scrolls across the
Overview. When this time marker reaches the center of the Overview dis-
play, the line will keep its position and the clips of the Arrangement will start
to scroll from right to left. This allows you to see not only what has just gone
by, but also what is up ahead, allowing you to anticipate elements of the Ar-
rangement. You can jump to a new song position in the Set by clicking any-
where on the Overview.

You can show or hide the Overview by checking it in the View menu.

The Track Headers

Track 1 Track 2

Track Headers for Tracks 1 and 2.

The Track Headers, found above each track, show the track names. You can
select a track by clicking on its header.

A selected track can be deleted using the Delete command from the Edit
menu.

New tracks can be inserted into the Session View by using the Insert Clip
Track/Insert Send Track command also found on the Edit Menu. The new
track will appear at the position of the currently selected track.

You can rename a track by double clicking in the header and typing in a new
name. Tracks can be re-ordered by dragging and dropping their headers.

The Master Track, at the far right of the Session View, can be neither de-
leted nor renamed. It is, essentially, hardwired into REMIX's audio chain.
Clicking on the Master Track Header allows you to see the Master Track’s
chain of effects if the Track View is open.
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The Clip Pool
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The Clip View, with several clips loaded.

The Clip Pool is the home for all of the clips you intend to use in a session.
It consists of a series of columns - one for each track. Each column is di-
vided into a number of slots, each one capable of holding a clip. The slots
are arranged horizontally as scenes.

I vackingos] [vassipez-1] [Faripoa-140] [ Ffitervoxa-{ [Fmixo3-140] [% 3 ]

A running scene.

A scene can contain a number of clips, which can all be triggered simultane-
ously by clicking on the scene’s play button on the rightmost column. You
can rename each scene by double-clicking in the scene slot and typing in a
new name. Scenes can allow you to organize your REMIX Set into songs,
with each scene corresponding to parts of songs or whole songs that can
all be triggered at once.

Load clips by dragging them from the File Browser and dropping them onto
a slot. You can overwrite currently filled slots by simply dragging a new clip
onto the old one. You can also copy and paste a clip from one slot to an-
other: [Option]-drag on a Mac, [Ctrl]-drag on PC, or use the Copy and
Paste commands from the Edit menu. Multiple clips can be moved or copied
by selecting and dragging them.

While dragging, holding the [Cirl] (PC)/[Command] (Mac) modifier key al-
lows you to select a vertical or horizontal arrangement for the placement of
the clips (i.e., down a column or across a scene).

You can also move sections of audio from the Arranger into the Clip Pool by
using the Copy and Paste commands. Select a starting slot to paste the au-
dio into and REMIX will generate a series of clips with all of the edits you
made intact and represented as individual Scenes.
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To trigger a clip, click the clip’s Play button:

[filtervoxz-1
A running clip.
It turns green to indicate that it is currently playing. If you have assigned
clips to keys on your computer keyboard you can of course also use these
for triggering. Find more info on page 25 in the Quick Start Guide. The clip
will begin playing based on the quantization rate you have selected.

Clicking the Stop button on an empty slot will stop any clips from playing in
that track and will instead trigger silence. Clicking an empty scene button
will do the same - all clips currently playing will be stopped and you will get
silence instead.

Clicking the play button of a clip already playing will restart it. You can set
different playback modes to determine how the clip will play once it has
been triggered. Refer to the Clip View section on page 23 below to learn
more about these modes.

The Track Status Fields

1 8 1 ] 2 4 a 16 0 16

Track Status Fields, showing four clips looping.

The Track Status line consists of fields that show the current state of any
clips that are currently playing. If a clip is set to loop, you will see a display
showing the color of the clip, the progress of the loop shown as a pie chart,
the number of times the clip has looped to the left and the number of quarter
notes (beats) in the loop to the right.

If a clip is set to one-shot, only playing once when it is triggered, you will see
a status bar, with a shaded area showing the progress of the clip. As when
a clip is looping, the color of the field will refer to the color of the clip. The
number of minutes and seconds remaining in the clip will be shown overlaid
on the status bar.

Track Status field, showing a one-shot clip.

If the track is playing an Arrangement, the Status field will show a graphic
representation of the audio in the Arranger View.

REMIX
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Track Status Field, showing an Arrangement.

The Track Status field also contains a Stop button that can be used to stop
whatever clip is currently playing in a track.

The Send Controls

( ) Sends
1

The Send Controls.

The Sends field let you control the amount of signal that is fed from the out-
put of each track to the input of the Send Track. REMIX has one Send Track
which you can insert in your REMIX Set.

The Send Track doesn’t do anything unless you assign one or several ef-
fects to it.

You can insert a Send Track by selecting the Insert Send Tracks command
from the View menu. Hide and show the Send Track by selecting Sends
from the View menu.

You can specify whether the Send controls tap the track signal before or af-
ter the track’s gain control by using the Pre/Post toggle switch on the right-
most column:

Sends
Fost

The Pre/Post fade switch for the Send.

It is also worth noting that you can route the Send Track’s signal back to it-
self: The Send Track has its own Send amount controls. You can thus gen-
erate a feedback. Be careful if you attempt this, however, as feedback levels
can result in audio signal overload and quickly rise to eardamaging levels.

REMIX
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The Mix Controls
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A track’s mix controls.

Every track has a mixer section with controls very much like ones you might
find on a broadcast-style mixing desk:

Meter/Gain: Volume control with an associated meter display.

Pan: For moving the sound within the stereo field.

Speaker: When this switch is on (lights up in green), the track’s output signal is
sent to the REMIX output. When it is switched off, the signal is muted; you can thus
use the Speaker switch as a mute button.

Headphones: This switch — not to be confused with the Headphone switch above
the Browser section - is used to switch the Solo function on or off. When it is
switched on (lights up in blue), only the signal of the corresponding track is audible.
All other tracks are muted unless the Solo function is also on. The Send Track is also
muted by the Solo function. That means, this works just like the Solo function on a
regular mixing console and it can be used to monitor individual tracks for editing. The
total output level of the Solo function can be set on the Master track using the blue
dial with the small headphones icon.

Microphone: The Microphone switch is used for real-time resampling. This is a
process where you record the output signal(s) of one or several tracks during a ses-
sion. You can then edit the resulting audio file like any other clip.

During the resampling process, the signal passes through effects that you
have assigned to the resampled track(s).

The resampling process is described on page 15 in the Quick Start Guide.

You can hide or show the mixer controls by selecting Mixer from the View
menu.

REMIX
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The Arranger View
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The Arranger View showing an arrangement of clips.

The Arranger View is the other main component of a REMIX Set. In this View
you can see an overview of audio clips arrayed on a linear time scale, and you
can use non-linear editing techniques to cut, copy, paste, and manipulate the
audio into new and interesting arrangements. You can then take these ar-
rangements and copy them into the Session View to be triggered as clips.

The most obvious use for the Arranger View is to view and edit your REMIX
Set after you've recorded it as a performance. This is where REMIX becomes,
in essence, an improvisational composition tool. With the right editing
touches any casual jam can become your next track.

The Arranger makes REMIX an excellent tool for remixing work. Any track
can be remixed by loading in and timewarping the entire track, and/or by
breaking it down into loops, editing the loops in the Arranger View, and then
even transferring them, in whole or in part, to the Session view for live
REMIX triggering.

Some of the elements of the Arranger View work a little differently from the
Session View. The most important difference is that, instead of being able to
select isolated audio clips like in the Session, the Arranger allows you to se-
lect time. Let us examine the elements of the Arranger View.

REMIX
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The Overview
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The Arranger Overview, showing a long arrangement.

The Overview in the Arranger functions in much the same way as it does in
the Session View — to show at a glance what is happening in the Arrange-
ment. However, whereas the Session’s Overview shows only part of the Ar-
rangement, the Arranger Overview always shows the entire Arrangement
from beginning to end.

The black rectangular outline represents the part of the Arrangement that is
displayed in the Track Display below. You can scroll in the Track Display by
clicking within the outline and dragging. By dragging the outline’s left or
right border, you can change both the scroll position and the zoom factor. If
you click on the center of the outline and drag up you can zoom out. Clicking
and dragging down zooms in on the view.

Loop and Start Markers

-4
>

1 3 5 7
backing01-140-auro

The loop and start markers. The loop markers are set to loop the first four bars of

this arrangement. The start marker is set to start the loop at bar 1.

With Loop mode switched on, you can endlessly loop any section of the Ar-
rangement. Turn Loop mode on by clicking the Loop button on the Control
Bar.

REMIX
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The loop marker is the dark blue set of brackets that slide freely above the
beat scale on the Arranger View. You can set a loop by clicking on the
marker and dragging it. If you place the mouse over the center of the loop
marker, the cursor changes to a special placement cursor. This allows you
to drag the loop marker, without changing its length, to any point in the Ar-
rangement.

>
1 13 |5 7
backing01-140-eurg

+—F

The loop marker has been moved to start the loop at bar 3.

If you place the mouse near the edge of the loop marker, the cursor changes
to a left or right bracket cursor, which allows you to change the length of the
loop marker. You can do this while REMIX is playing, and hear the effect of
the change immediately.

>
1 13 |5
backingl1-14§-eurc

Here, the loop has been shortened to loop only bars 3 through 5.

The start marker, the vertical line with a small triangular flag, allows you to
set the point at which the Arrangement starts playing. In the image below,
the Arrangement will start playing at bar 3. You can move the start marker by
clicking on it and dragging.

[
>
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The triangular marker represents the playback startpoint.

Time Rulers

Above and below the Track Display you see the Time Rulers: the upper ruler
displays meter time; the lower ruler displays time in seconds. By clicking any-
where in one of the rulers and dragging horizontally, you can scroll the Track
Display. The meter time ruler also allows you to continuously change the

zoom level by dragging vertically. Drag up to zoom out; drag down to zoom in.

REMIX
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The Track Display
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The Arranger Track Display, showing eight tracks filled with clips.

The Track Display shows you a time-based overview of your clips, envelopes
for any automation you may have in your Arrangement, and a small version of
whatever mixer controls you have selected from the View menu.

This allows you to make changes to the mix, such as adjusting the pan, send
amounts, etc. The mixer in the Arranger is functionally identical to the mixer
in the Session View. For details, please see the discussion of the mixer on
page 12.

When you first open the Arranger View, all of the tracks will be folded in.
Their reduced size allows you to see many tracks of data at once.

Next to the name of a track is a triangular button which is used for folding in

and out the track:

Track 1
Track 2
Track 3

Track 1

Track 2
Track 3

When unfolded, tracks show the clips’ waveforms.

REMIX
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When a track is folded in, you can only select and move entire clips, exactly
like in the Session View. When unfolded, you can view and edit the clips’
waveform, allowing you, for example, to cut a clip in half and move only one
piece of it. Automation breakpoint-envelopes are also only accessible when
a track is unfolded.

Selecting Clips and Time

Click on a clip box to select the entire clip. The selected clip's properties
can then be viewed and changed in the Clip View.

Click on a clip box and drag the clip to another position within the same
track, or to another track.

You can also drag clips to the Session View chooser button to open the
Session View and drop copies of the clips there.

When the (white) mouse pointer is over unoccupied space in the Track Dis-
play, or over a clip’s waveform, it turns into an insert mark (black arrow). You
can now select a point in time by clicking; a slowly flashing insert mark will
appear to mark the selected time position. Clicking and dragging horizon-
tally selects a time span. Dragging across neighbouring tracks extends the
selection to include these tracks.

Tarminall rminall

When the waveform has been unfolded, you can move the clip by dragging its title
bar.

REMIX
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Often, you will want to select only part of a clip (to cut it out, for instance).
This can be easily achieved by unfolding the track and selecting the time
span in the clip’s waveform.

Tarminali

Clicking and dragging in the waveform, or in the Track Display’s background
selects time.

If you do not require to see the waveform for making the selection, you can
also hold the [Option]/[Alt] modifier key on your computer keyboard while
clicking into the clip box and then drag to select the desired time span. You
are temporarily switching to the time selection cursor, saving the effort of
unfolding the track.

When selecting time, the selection is horizontally constrained to a raster.
Two choices are available from the Options menu. Both are alternatively
available on the Options menu; i.e.: when one of the two functions is active,
you can select the other on the menu:

Choose Snap to Grid Lines to quantize to the ruler marks. Because the ruler mark
spacing adapts to the current zoom factor, Snap to Grid provides you with a reason-
able raster for selection and editing regardless of the zoom factor.

Choose Snap to Quantization to use the global quantization setting as a raster for
selection, editing, and moving markers. The global quantization can be set using the
Options menu or using the pop-up menu in the Control Bar. If you do not want to use
a raster for editing at all, set global quantization to None.

Holding the [Ctrl] (PC)/[Command] (Mac) modifier key or the [Shift] modi-
fier while clicking or while dragging extends the selection across time and
tracks. Use the [Cirl] (PC)/[Command] (Mac) modifier key to add individual
tracks to the selection; use the [Shift] modifier to include a range of tracks.

REMIX
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Editing in the Arranger View

In the Arranger View, there are a number of editing methods available for
making changes to the selected clips/time span. Since all of the techniques
are non-destructive, you can undo them at any time.

Most editing in the Arranger View is selection-based. Making a change is a
two-step process:

Select a point in time, a time span, a clip, or several clips;
Select an editing command from the Edit menu to do something with the selection.

All commands in the Edit menu have keyboard shortcuts. By using those
shortcuts you can develop a very efficient working method where one hand
operates the mouse to make selections and the other hand calls up the ed-
iting commands by pressing the corresponding computer keys.

Please see the section “The Menu Functions” on page 47 for explanations
of all Edit menu commands.

Changing a Clip’s Length

Aside from using the Edit menu commands, you can reduce and increase

the length of a clip with the mouse cursor. Holding the mouse cursor near
the edge of the clip changes it to a right or left bracket. Clicking and drag-
ging towards the beginning of the clip reduces its length.

e

]

Dragging a clip’s right edge to change its length.

Holding the cursor near the front of the clip and dragging reduces it in
length from the beginning towards the end.

1 3 5
[

Dragging a clip’s left edge to change its length.
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Dragging the right bracket cursor beyond the length of the sample extends
the clip’s duration for as long as you drag. The length of a clip is unrestrained
and independent from the duration of the sample that is used. New loop rep-
etitions appear as you increase the clip length. Notice that dark vertical lines
appear in the clip box to indicate where new repetitions begin. To learn how
to change the clip loop, please see the discussion of the Clip View below.

Increasing a clip’s length, and thereby creating new loop cycles.

Editing Envelopes

An envelope is the graphic representation of automation data. You can view
and edit envelopes by unfolding a track, using the triangular button next to
the track’s name.

You can view a different envelope for each mixer or effect control. To
choose the control whose automation you would like to view and edit, sim-
ply select it, either by clicking on it or using key command navigation (see
page 62.). The selected control's name will appear below the track name.
Notice that all automated controls have colored corners around them, mak-
ing it easy to identify the controls you have recorded automation for.

M4 P45 9452 (9453 (9454 (P46 9462 946
L5 | |

A breakpoint envelope, overlaying a clip waveform.

An envelope is shown in the Arranger View as a thin line containing small
boxes, called breakpoints. The breakpoints break the line down into smaller
sections, in order to represent curves.

REMIX
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You can move a breakpoint by clicking on it and dragging it. To move sev-
eral breakpoints at once, select a time span by clicking into the track back-
ground and dragging; then, move any breakpoint within the selection. All
other breakpoints in the selection will follow the movement.

There are a number of Edit menu commands you can apply to envelopes in
the Arranger View. Please see page 47 for an in-depth discussion of these
commands.

The Track View

Modulating Delays
Dolay1 | Dolayz Modulation | Fasaback

Drop a dovics horo.

Tracks LWV
The Track View, with three REMIX effects loaded.

Every Clip Track, the Send Track, and the Master Track have the capability
to host an unrestrained number of REMIX effects and/or one external VST
plug-in effect. The Track View is where you insert, view, and adjust the ef-
fects for the track that is currently highlighted in the Session View, or in the
Arranger View.

The Track View functions much like the insert path on a standard mixing
desk. Any effects loaded here are placed before the Send outputs and the
gain stage of the Mixer. One hundred percent of the clip signal is sent into
the effects in the Track View. In this way, the effects in the Track View func-
tion like insert effects — unlike when using the Sends, where only a certain
amount of the clip signal is sent to any effects there (controlled by the Send
levels on the Mixer). The effect works on the whole signal, not merely a por-
tion that has been tapped off of the main signal.

To hear more or less of each effect on the clip signal, you can use the Wet/
Dry controls that many effects feature. If this parameter is not available, the
complete signal will be processed and sent to the volume fader of the Mixer.

Load effects by selecting them from the REMIX effects or Plug-in effects
browsers and dragging and dropping them into the Track View. Audio trav-
els from left to right on the track, and you can drop effects in at any point —
even between other effects, thereby changing the character of the signal
processing.

REMIX
21



You can remove effects from the chain by clicking on their title bar and
either pressing your computer's [Delete] or [Backspace] key, or by selecting
Delete from the Edit menu. To re-order effects, simply drag an effect by its ti-
tle bar and drop it between any of the other effects in the Track View.

Generally, effects can be placed, re-ordered and deleted without an inter-
ruption in the audio stream.
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The Clip View.

Clips are the basic building blocks of a REMIX Set. In essence, a clip
stores:

A reference to a sample stored on your computer’s hard disk;

Markers that identify what part of the sample to play;

Information on how to start and stop playing the sample in response to your actions;
Transposition and gain controls for sample playback;

The warp markers and additional warp settings that determine how to time-stretch
and compress the sample.

It is important to understand that changing the settings of one clip will nei-
ther affect any other clips, nor change any samples. You should also notice
that a clip is a lightweight thing: Usually, you can fill up your REMIX Sets
with lots of clips without running into memory shortage.

The Clip View is where you can view and edit the properties of the clip that
is currently selected in the Session View, or the Arranger View.

One difference between the Clip View and the Track View is worth noting:
the Track View will always display the currently audible state of the selected
track’s effects; the Clip View, on the other hand, displays whatever clip is
selected, whether it is running or not, thus allowing you to prepare a clip
prior to launching it.

Let us look at the different components of the Clip View.
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Clip Settings

Clip The Clip settings box gives you the name of the clip that
you have selected. By default, the name of a clip is identi-
congal1-12%| o4 to the name of the sample it plays.
Color The name can be changed by clicking in the name field. It
w | also allows you to set the color for the clip by using the
Launch Mode| Color pop-up menu.
Trigger The Launch Mode selector and the Loop switch allow
Gale you to change the way a clip plays when it is launched via
Toggle the mouse or your computer keyboard.
Repeal Since you can only launch clips in the Session View,
these settings have an immediate relevance only to clips
Loop . . .
= 4| inthe Session View.
Bar - . .
= 2| The Clip settings box.

So, why are the launch settings available for Arrangement clips at all? As we
have seen when recording a session, REMIX places copies of the original
Session clips into the Arrangement. Those copies have to “remember” the
original launch settings, so they can be restored when you drag or copy
clips from the Arrangement back into the Session View.

Here are the available Launch Mode choices:

Trigger: Mouse down starts the clip; mouse up is ignored.

Gate: Mouse down starts the clip; mouse up stops the clip.

Toggle: Mouse down starts the clip; mouse up is ignored. The clip will stop on the
next mouse up.

Repeat: As long as the mouse is down, the clip is repeatedly triggered at the quan-
tization rate set in the Control Bar. This can produce various stuttering effects if a
high quantization is set.

The gate, toggle, and repeat launch modes are not available when launch-
ing clips from computer keyboard keys. The computer keyboard keys al-
ways launch clips in Trigger mode.

When the Loop switch is activated, the clip’s running time is potentially infi-
nite. When Loop is off, the clip will automatically stop playing when one loop
length worth of time has passed since start.

Please notice that, regardless of the chosen launch mode, a running clip
will stop playing when another clip is started in the same track, or when the
track’s stop button is clicked.
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You can use the pop-up menu at the lower rim of the Clip settings box to
make an individual quantize setting for the currently selected clip. The fol-
lowing options are available:

Option
Gilobal
None
8 Bars
4 Bars
2 Bars
Bar
1/2
1/4
1/8
1/16
1/32

Description

The clip uses the global Quantize setting.
No quantizing takes place.
8 bars

4 bars

2 bars

1 bar

Halve a bar

A quarter bar

An eighth bar

A sixteenth bar

A thirtysecond bar

Sample Settings

Sample Settings
congall-125-hworx
44,1 kHz 16 Bit 2 Ch
Edit Repl Save
Hi-Q | Fade
Tranipos.e ™ Gain 7

05T

Dretune
Oct + 1.26dB

The Sample Settings field gives you specific informa-
tion about the sample the clip plays: file name, sample
rate, bit-depth, and channel count of the sample.

When you move the mouse over the file name, the full
directory path to the sample will be shown in the Status
Line.

The three buttons below the info fields help you man-
age samples:

The Sample Settings box.

When the Edit button is clicked, Remix opens the sample in a sample-editor applica-
tion, provided that you have one on your computer. You can choose which sample-
editor application to use in the Preferences dialog's Misc tab. To process a sample in
an external program, you will have to stop REMIX's playback. Any changes that are
made to a sample in an external program will be inmediately audible when you return

to REMIX.

[0 Note that changes may affect other clips playing the same sample, too.
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The Repl button brings up a standard file selector box that can be used to choose a
sample to replace the current sample. Notice that the file will be replaced in all other
clips playing the same file, too. This function is very useful for locating missing files.
When you open a REMIX Set in which there are references files that have been re-
named or moved since saving, REMIX will ask you if you would like to locate the
missing files. If you do not feel like doing that piece of administrative work, the Repl
button will allow you to do so at at later time.

The Save button saves the current clip’s settings with the sample. After this has
been done, Remix will restore the current clip settings whenever you drop the sam-
ple into a REMIX Set. This is especially useful with regards to the warp markers,
which have to be correctly set for REMIX to play long files in sync.

Notice that you can use the Save button without affecting any existing
clips. Save just saves default settings for future clips using this sample.

The clip data is stored in a file that also contains the results of an analysis
carried out by REMIX when a sample is first opened. The size of this file is a
small fraction of the size of the sample. The analysis file is saved in the same
directory as the sample, under the sample’s name, with an “.asd” extension.
You can prevent REMIX from creating “.asd” files by deactivating “Create
Analysis Files for Samples” on the Preferences dialog’s Misc tab.

The two switches in the middle of the Sample Settings box are used to set
the sample playback characteristics.

The Hi-Q switch places the clip in high-quality playback mode. REMIX will use a
more sophisticated interpolation algorithm to read out the sample. The sound will be
played with fewer artefacts, at the expense of higher CPU drain.

The Fade switch applies a short, approx. 5 millisecond fade to the start and end of
the clip when turned on. This is used to avoid clicks at the clip edges.

The Transpose control lets you shift the pitch of the clip in semitones, inde-
pendently from tempo.

The Detune control allows fine settings to the Transpose amount. The De-
tune value is specified in Cents (one hundred Cents equal one semitone).

The Gain control sets an amplification/attenuation factor for the clip’s vol-
ume, allowing you to adjust each clip’s volume independently from the mixer
and effect gain stages.

REMIX
25



Loop Settings

Loop
Start

End

Length
FI

L gl
Qi 0

The Loop settings box displays the Start and End point
of the looped portion of the sample and shows the over-
all Length of the loop. It also indicates the start Offset.

1/| You can click and drag up or down in the Range fields to

change the values, or use the arrow keys.

11| The start offset is the time delay, measured relative to the

loop start point, where the clip starts playing the sample.
Notice that changes to the start offset have an immediate

0’| effect on a playing clip: sample readout jumps so the clip

sounds as if it had been launched with the new offset
setting.

This behaviour allows you to phase-shift loops against
one another while they are running.

The Loop settings box.

Warp Settings

Warp
Cirig. BPM
125.00
2.2
Signature
EXE
Transients
116

The Warp box.

The settings in the Warp settings box, in combination with the
warp markers, control the time warping engine's operation.

The Original BPM control (bpm = beats per minute) is used
to inform REMIX about the original tempo of a sample, or part
of a sample.

Please see the discussion below (Setting the Warp Markers)
to learn more about preparing samples for beat-synchronized
playback.

The small pop-up menu under the heading Transient lets
you adjust the playback quality of the clip and thus reduce
unwanted artefacts from the time warping process. Tran-

sients mark the positions in the sound where events start.

The transients play an important role in achieving good sound quality when
stretching or compressing a sound.

Setting the Transient rate imposes a meter-based grid onto the sound. If you
set this to 1/16, the time warping engine assumes that transients occur at
every sixteenth note (which is a good guess for most modern, popular mu-
sic). 1/16 may be too dense a grid for sounds that only contain few event
onsets. When stretching or compressing bass lines, for instance, you may
achieve better results with lower Transient settings like 1/8 or 1/4.
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The Sample Display

T

i S L U P L P L i
0.00.01.100 0.00.02.200 0.00.03.300 0.00.04.400 0.00.05.500

T P R
0.00.00.000 0.00.06.600

The Sample Display,

The Sample Display is where the clip is displayed as an audio waveform.
You use it to adjust the clip’s loop and start offset, and to place warp mark-
ers for clips with tempo changes and unsteady rhythms.

The Sample Display provides a number of zooming and scrolling techniques
which allow you to access any part of the sample very quickly.

Navigating with the Clip View chooser tab. The rectangle at the left side of the
picture represents the visible range; the bright area at the right side represents the
loop.

The Clip View chooser tab shows a miniaturised picture of the entire sam-
ple. This picture also shows you the audible, and the visible part of the
sound:

The audible part is the loop that has been selected. The looping region is drawn in a
bright color.

The visible part is the region of the sample currently displayed in the Sample Display.
It is represented by the rectangular outline overlaying the picture of the sample.

The rectangular outline is not only used for showing the visible part, but also
for changing it. Clicking inside the rectangle and dragging it horizontally, like
a “normal” scroll bar, scrolls the Sample Display. By dragging the left and
right end of the rectangle, you can adjust the visible range, thereby chang-
ing the zoom level. Dragging the small gray box in the center of the rectan-
gle, you can scroll and zoom the Sample Display at the same time: drag up
to zoom out; drag down to zoom in; drag left/right to scroll.

The most common and effective way to scroll and zoom is dragging directly
in the Sample Display. When zoomed all the way out, click on a position in
the waveform display that you want to see magnified. Then, drag down to
zoom in. You need not let go to scroll the display: just drag left or right. The
mouse acts as anchor for zooming and scrolling.
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Setting Loop and Offset

36 42 45
- = I = = =
Markers in the Clip View's sample display: the loop marker, the start marker, the
offset marker, and three warp markers (top to bottom)

The topmost area of the Sample Display is occupied by the loop marker and
the start offset marker:

The loop marker. By dragging the center part of the loop bracket, you can move the
loop without changing its length; by dragging the left and right edge, you can change
the loop start and end points, independently. You can achieve the same results by
changing the values in the Loop box.

The start offset marker. The start offset marker represents the position in the sample
where the clip starts playing. Dragging the start marker while the clip is playing has
an immediate effect. The start offset marker is constrained to a position inside the
loop. You can also change the start offset by changing the values in the Loop box.

As in the Arranger View, marker movements in the Clip View are constrained
by a quantization raster. Two alternative choices are available on the Op-
tions menu (only one is visible at a time):

Choose Snap to Grid to quantize to the ruler marks. Because the ruler mark spac-
ing adapts to the current zoom factor, Snap to Grid provides you with a reasonable
raster for selection and editing regardless of the zoom setting.

Choose Snap to Quantization to use the global quantization setting. The global
quantization can be set using the Options menu, or with the pop-up menu in the
Control Bar. If you do not want to use a raster at all, set global quantization to None.

Setting the Warp Markers

The warp markers are used to enforce a rhythm grid onto the sample. A
warp marker ties a sample position to a meter time.

When using perfectly cut loop samples, you will not have to adjust the warp
markers. REMIX makes an assumption about the loop’s original tempo, which
is shown in the Warp box’s Original Tempo field. In most cases, REMIX's es-
timate is correct; sometimes, however, the estimate is wrong by factor two or
half. As a consequence, REMIX will play the loop twice as fast, or half as fast
as needed. If so, use the : 2 and * 2 buttons next to the Original Tempo field
in the Warp Box to inform REMIX about the actual original tempo.
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When you load a sample that is not a perfectly cut loop, you will have to
make a couple of adjustments. This is the case not only for badly cut loops,
but also for long samples which contain many bars of music, maybe a com-
plete piece. Proceed as follows:

Choose Snap to Quantization from the Options menu; set the quantization
to one bar; in the Loop box, set the loop start to 1.1.1 and the loop length to
1.0.0. The offset should be 0.0.0.

Begin with identifying the first beat. This is the position in the file where
the loop, or the piece, actually starts: bar one, beat one. Drag the warp
marker with the ‘1’ label to the position that you think could be the first
beat. If the first beat is not in view, just keep dragging the warp marker; the
view will automatically scroll.

Notice that the loop marker and the offset marker follow as you drag the
warp marker. This happens naturally, because the loop and offset markers
are tied to the ruler. By moving the warp marker, you are actually moving
the ruler.

143 12 123 13 133 14 143 243 22 223 23 233 24 243 2

" ,,} ( " Mm

The sample’s first beat has been identified: a bass drum.

Launch the clip to check if you have actually found the first beat. Probably
it will take you a couple of tries to find it. Notice that you can re-trigger the
clip to test by hitting the space bar to stop and start again. Zoom into the
waveform to acurately set the warp marker.

When you have successfully defined the first beat, your next task will be to
identify the original tempo of the sample. Should you happen to know the
original tempo, simply type it into the Warp box’s Original Tempo field. If
the sample was exported from another sequencer program, you can copy
the original tempo. As you type in a new tempo, observe the change in the
meter grid in the Sample Display. If the original tempo is correctly specified,
the meter grid lines will more or less align with the events in the sample.
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To verify your settings, play the clip. You should hear a “round” loop.
Sometimes, playing another looping clip with a straight base drum along
the clip you are preparing also helps to find the beat.

If you do not know the original tempo, or if you want to fine-tune a rough
tempo assumption, move the mouse to one of the triangles above the me-
ter grid lines; click and drag the triangle to move the grid line left or right
so it fits to the waveform. Regardless of which grid line you are moving, the
other grid lines will follow proportionally, and the loop end will move with
the grid lines. The Original Tempo readout will reflect your changes as well.
Eventually, you will see and hear a perfect one-bar loop.

The sample’s original tempo has been identified; now the grid line at bar 2 aligns
with another bass drum beat.

You should now also test if the following bars sound right. Move the loop

ahead by one bar. If this loop sounds right, and looks right (do not forget to
zoom in to make sure the grid lines at the loop boundaries fit to the wave-
form), proceed to the next bar, etc. At some point, you will probably have to
fine-tune the meter grid by dragging a grid line left or right.

Sometimes, especially when working with recordings from REMIX musi-
cians, you will come across conditions like this: While the first couple of
bars looped fine, you run into a bar that needs adjustment; however, when
you drag the grid lines to adjust the meter, the bars before the current bar
will not fit anymore. You cannot seem to find one tempo to fit all bars. Obvi-
ously, the sample contains a tempo change.

You can easily solve this problem by creating a warp marker to “fix" a grid line.

Double click one of the triangles which you normally use as handles to
drag the grid lines; a new warp marker will appear. The warp marker de-
fines a new tempo section. You can adjust the grid lines at the right hand
side of the warp marker without affecting the warp marker’s position, or
the meter grid left from it.

1;17»:\sE:sw:’au«unssia:asﬂs’

P M

Because the sample contains tempo changes, a couple of warp markers had to be
inserted.
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Of course, you can always change the position of a warp marker by drag-
ging it. Notice that the tempo which is displayed in the Original Tempo field
is the tempo at the right hand side of the selected warp marker. You cannot
drag the grid lines between Warp Markers, because the warp markers fix
the meter. You can, however, click and drag to open a selection rectangle
around several warp markers at once to move them, or to delete them.

Sometimes, after all warp markers have been perfectly adjusted, you realize
the first beat was not actually set correctly.

* In this case, just add a new warp marker at the actual first beat’s position.
If there are any warp markers before the new first beat, delete them. The
leftmost warp marker always defines the first beat.

Using warp markers, you will be able to align any sample to a straight beat:
simple beat loops as well as entire works of jazz music, classical music, etc.

The File Browsers

< @ % SoundFiles
| Big Fish Audio Filss for Live
[ breakbeat vol 1 (drmips)
. Gut'n it up vol 2 (hip-hop)
ﬁ ebectric ghatto
B o011020pmp
8 03132bpm E
0 journey to the light (d&b)
. megaton house bomb

8]

- megaton trance bomb
- thing that go bump volt (s
B xparts of techno
B 7th City 140bpm
(B JB Three 135bpm
E bass grain.waw
E chord industry wawv
FX crowd.wav
loop BO.wav
loop clap.wav
loop HH.wawv
loop OH.wav

loop ride.wav

IFEEEEE

lsop snap.wav

A File Browser.
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The three File Browsers are REMIX's interface to your hard drive. You will
use them to locate folders of samples, clips, and REMIX Sets.

Navigating the Directory Hierarchy

Navigating the directory hierarchy is very simple. For each of the File Brows-
ers, clicking the Directory button will move the view up one step in the
disk hierarchy. Click it enough times and you will end up at your computer’s
desktop.

.

The Directory Button moves a browser up one step in the directory hierarchy.

Clicking the Root button makes the currently selected folder the new root
directory of the File Browser. This is useful when you have located a folder
of clips or REMIX Sets that you will use often.

+

The Root Button makes the currently selected folder the root directory.
You can use your computer's up/down arrow keys to navigate between fold-
ers and files in the Browser View.

Pressing the right arrow opens a folder, displaying its contents. Pressing
the left arrow closes a folder.

Loading Sets, Samples, and Clips

To load a clip or sample, simply select it from the File Browser and drag it
onto a clip slot. You can drag new clips over old clips, replacing the old file.
In the Arranger View, you can drag clips directly into the Arrangement. New
clips will overwrite any existing audio that they are placed over.

You can load REMIX Sets by locating them in the File Browser and double-
clicking on them. You can also use the Open command in the File menu.
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The Effects Browsers

A
7
3

Four EQ
Chorus
Filtar Delay

9

()

L)

£} Erosion
£) Auto Filter
E] Cross Dalay
£) Vinyl Distortion

The REMIX Effects Browser.

REMIX uses two separate browsers to organize and load the REMIX ef-
fects, and the VST plug-ins. Both browsers look and work identically. Ef-
fects are loaded into the selected track by dragging them onto the Track
View. Double-clicking an effect appends the effect to the end of the se-

lected track’s effect chain. Please see the section “The Remix Effects” on

page 41 for a listing and discussion of the REMIX effects.

Working with VST Plug-Ins

BJ Ringmodulator2
Edit Init - Frag. LFO WF Volume
A A A
10166 Hz Hine -6.021 dB dB
IWtix LFOZFraq.
A A
1000 0 o 0.0 Yo
Osc. WF LFO2Val
Y A
Exp Down 0.0 b
LFO Freg LFO rtrg.
Freq. y OscWiy 1.00 Hz 0.000 dB 4B
A VST plug-in.

Before REMIX can access a VST plug-in, you must first locate the VST plug-

in directory that you wish to use.

To do that, open the Preferences dialog from the Options menu.
Under the Misc tab you will find the VST Plug-In Directory entry.
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2. Click the Browse button to open a directory dialog and locate and select
the VST plug-in folder that you want to use.
The VST Plug-Ins Browser will then display all plug-ins it finds in the VST plug-in di-
rectory, and its subdirectories.

In the Track View, the original VST plug-in panel graphics will be replaced
with a REMIX panel; all parameters of the VST plug-in are represented in the
REMIX panel and work in the same way. You can e.g. select an automated
plug-in parameter and edit its automation in the Arranger.

You can show or hide the VST plug-in's parameters by toggling the triangle-
shaped button in the plug-in's header.

The Edit button in the upper left of the effect panel opens a floating window
that shows the original VST plug-in panel. Changing parameters on the
floater window has the same effect as changing them in the REMIX panel,
and vice versa. You can access any presets the VST plug-in may have by us-
ing the pop-up menu to the right of the Edit button. You can assign any two
plug-in parameters to the REMIX X-Y control by using the pop-up menus im-
mediately beneath it.

Kariette
Edit |Init 1 -

L

Delay 1 |y Delay2 |5

The X/Y control.
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Setting REMIX Preferences

The Preferences dialog contains several settings that control REMIX's oper-
ation. To open the Preferences dialog, select “Preferences” from the Op-
tions menu. The dialog pops up as a separate window. You can access the
REMIX main window at any time while the Preferences dialog is up.

[0 Note that the Preferences settings are saved with the application. Loading
and saving REMIX Sets does not affect the Preferences settings.

The Preferences dialog contains three tabs: Misc, Paths, and Audio.
Click on a tab to access the associated settings.
Misc

The Misc(ellaneous) Preferences control various aspects of REMIX's behav-
iour and appearance.

A Prelerences [ ]

Bohaviour

Glip Update Rate: sy

Creats Analysis Files: On

Record File Type: Aiff 16 Bit |y
Select On Launch: on

Appearance

Load Skin: Bright 5
Track Height (Arranger): 120 px

Chooss Language: us-English =
Clip Defaults

Launch Moda: Triggery

Loop: On
Quantisation: Giobal [y

Auto Assign Colors: On

Default Clip Color:

The Misc Preferences tab.
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Clip Update Rate

The clip update rate is the rate at which REMIX updates a running clip’s set-
tings. Play a clip from the Session View and open the Clip View to access
the clip's settings; when you change the controls (Transposition, for in-
stance) you will notice your changes are quantized by the rate you have
selected from the Clip Update Rate pop-up menu.

As discussed in the section “Operating Remix” on page 20 of the Quick Start
Guide, REMIX is able to record your session clip playing and control changes
into the Arrangement. When you change a running session clip’s controls
while the Control Bar's Record switch is on, REMIX creates copies of the clip
at the selected Clip Update Rate and puts them into the Arrangement.

Create Analysis Files for Samples

REMIX carries out an analysis of every sample loaded. The analysis data are
used to speed up the waveform display and to improve the time warping en-
gine's operation. When the “Create Analysis Files” option for samples is
turned on, the analysis results are stored in a so called analysis file. The next
time you drag this file into a REMIX Set, REMIX simply reads the analysis
data from the analysis file instead of running the analysis once more.

The analysis file is put into the same directory as the sample. It's name is the
sample’s name with an “.asd” extension. The analysis file is very small when
compared to the sample. If you nonetheless want to prevent REMIX from
“polluting” your disk with asd-files, uncheck “Create Analysis Files”.

Record File Type

This is used to select a file format for the files that you create by resampling.
These options are available on the pop-up:

WAV file in16 Bit format
AIFF file in16 Bit format

WAV and AIFF are standard audio formats on the PC and on the Macintosh.

Select on Launch

When you activate this option so that the switch displays “On" and lights up
in green, the Tracks or Scenes are selected by manual triggering.

Load Skin

REMIX offers a selection of different user interface colours. You can select
the desired new skin from this pop-up menu. Colours will change at once.
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Track Height (Arranger)

Use this field to define the vertical size of a track’s unfolded waveform dis-
play in the Arranger view.

Click into the field, hold down the mouse button and move the mouse up-
wards to increase the number of pixels or move it downwards to decrease
the number of pixels.

Choose Language

You can switch REMIX to other user interface languages. German, English
and French are available.

Select a new language in the pop-up menu. You must restart the program
for the change to take effect.
After the restart, the REMIX user interface will be shown in the selected language.

Launch Mode

This is where you determine how new clips are triggered, when you start
them with the mouse or via your computer keyboard.

You can set this individually for each clip in the Clip View. Find more details
on page 23.

Loop

This is where you determine, whether new clips are played back as loops —
i.e. whether they are “indefinitely” repeated.

You can set this individually for each clip in the Clip View. Find more details
on page 23.

Quantisation

This is where you determine the quantization grid for triggering new clips.

You can set this individually for each clip in the Clip View. Find more details
on page 24.

Auto-Assign Colors to Clips/Default Clip Color

When the Auto-Assign Colors switch is turned on, REMIX will assign ran-
dom colors to new clips. Otherwise, new clips get the color you have se-
lected on the Default Clip Color pop-up menu.
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Paths

This tab of the Preferences dialog is used to define various path settings.

VST Plug-In Directory

Click to locate the VST plug-in directory. REMIX seeks VST plug-ins in the
selected directory and displays the available VST plug-ins in the External Ef-
fects Browser (see page 16 in the Quick Start Guide).

Audio Recording Directory

Click to select the recording directory. The recording directory is the default
location for the samples you record in REMIX. Please see the section “Op-
erating Remix” on page 20 of the Quick Start Guide to learn about record-
ing audio in REMIX.

Sample Editor Application

Click to select a sample editor application that is installed on your computer.
When you later click the Edit button in the Clip View, REMIX will launch the
sample editor application you've selected and makes it open the sample
used by the selected clip.

Audio
The Audio Preferences settings are used to manage REMIX' audio output.
X Preferences B
Device Type: ASIO -
Device: ASIO 5T24196 -
Buffer Size: 2048 Samples
Output Latency: 48 ms
Clock Source: Settings
Hardware Selup
Output Config
Sample Rate: 44100 o

The Audio Preferences tab.
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Device Type

The Device Type pop-up menu is used to choose among the types of audio
drivers available on your computer. On the Macintosh, REMIX currently sup-
ports SoundManager and ASIO; on Windows, REMIX supports DirectX/
MME and ASIO. Usually, ASIO drivers are the preferred choice because
they allow for lower latency times, especially under Windows.

The term latency denotes the delay between the moment at which the signal
appears at the audio hardware’s inputs and its availability within the software.

ASIO drivers are available for almost every professional audio I/O interface.
Please consult your audio hardware’s vendor. The presence of several of
the settings described below depends on the chosen device type.

Device

Use the Input Device pop-up menu to choose among the available audio in-
put devices that match the Device Type setting.

Windows only: When you've chosen DirectX/MME from the Device Type
menu, the Input Device menu will show you, for every available sound card,
an MME driver, and probably also a DirectX driver. MME is the oldest audio
driver technology on PCs, and an MME driver is available for almost every
sound card. MME requires very high latency settings, however, and is there-
fore not recommended for use with a real-time audio application. DirectX is
a more recent technology from Microsoft, allowing for lower latency settings
than MME drivers. Unfortunately, not all DirectX drivers are examples of
good software, crashing the client application or the operating system when
selected. If this happens, REMIX will restart with no Input Device selected.

Buffer Size/Output Latency

The Buffer Size setting determines the latency, thus the delay between the
actual creation of an audio signal in REMIX and the moment when it be-
comes available at the audio hardware outputs. REMIX reports the input la-
tency in milliseconds, and the buffer size in samples.

A small output latency value is important. It makes sure that REMIX can
quickly react to your actions.

If you have selected DirectX/MME or SoundManager as Device Type, a con-
trol for setting the Output Buffer Size becomes availalbe on the Audio Pref-
erences tab. You can use this control to find the minimum latency that is
workable on your system. Please follow these steps:

Connect an audio source to the inputs of your audio hardware.
Set the Output Buffer Size control to its maximum value.
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Load a clip into a track and start it. For this test, a pad sound is more suitable than a
sound with many pauses.

Add effects (preferably to other tracks, not to the monitored track) until the CPU load
indicator on the Control Bar reaches a fairly high value (ca. 70%).

Slowly reduce the Buffer Size value, until you can hear drop-outs or crackle. Find a
value just high enough so the signal gets through undisturbed.

If you have selected an ASIO device, please click the button labelled “Hard-
ware Setup” to access the device's specific setup dialog. Most ASIO driver
setup panels have controls to adjust the Buffer Size. Please refer to your au-
dio hardware’s documentation.

Output Config Button

If you have an audio card with more than on stereo output, click on this but-
ton to open a dialog where you can select any of the available stereo output
pairs.

Sample Rate

Use the Sample Rate setting to choose the sampling rate at which REMIX
generates, and outputs, audio. Higher values produce “cleaner” output at
high frequencies, at the expense of increased CPU drain.

Because REMIX performs a real-time sample-rate conversion, samples with
arbitrary sampling rates can be read, no matter which output sample rate
you've selected. The sampling rate of samples recorded in REMIX will al-
ways be identical to the output sample rate, however.

Depending on the selected Device Type, the sampling rate may be fixed
(usually to 44,100 Hz).
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The REMIX Effects

REMIX comes with a selection of specially designed, built-in effects. You
can locate them by clicking on the REMIX Effects Browser button in the
Browser View.

Auto Filter

Auto Filter

Envelape: LFO / SEH
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Y
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The Auto Filter effect.

The Auto Filter effect provides a classic analog filter emulation with four fil-
ter types. It can be modulated by an envelope follower and an LFO for cre-
ating moving filter effects.

Autofilter can be switched between four filter types: low pass, high pass,
band pass, and band reject. For each type, the XY controller lets you adjust
frequency and Q, or resonance. Clicking and dragging on the X-axis adjusts
the filter frequency, while clicking and dragging on the Y-axis adjusts the Q
amount. You can also double-click on the Freq and Q numeral displays to
type in exact values. Low Q values create a smoother filter curve, while
higher values introduce “resonance” to the sound.

In band pass/reject mode, Q defines the bandwidth of the passed or re-
jected signal.

The Quantize Beat control allows you to apply quantized modulation to the
filter frequency. With Quantize Beat off, frequency modulation is apparently
smooth and immediate. Turning this feature on causes filter modulations to
be updated rhythmically, with “stepped” changes in reference to the master
tempo. The numbered buttons represent 16th notes, so, for example, select-
ing 4 for Beat value produces a modulation change once per beat.
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The Envelope Mod section lets you control the amount and character of en-
velope modulation on the filter frequency. The Mod control defines how
much the envelope affects the filter frequency.

The Attack control allows you to set how the envelope responds to rising in-
put signals. Low attack values mean fast response to input, while high val-
ues create a smoother, more delayed response.

Lower release values cause the envelope to respond more quickly to falling
input signals. Higher values extend the envelope's falling state.

The Autofilter also contains a low frequency oscillator (LFO) to modulate fil-
ter frequency. Use the Amount control to set how much effect the LFO has
on the filter.

The Rate control specifies the LFO speed. You can select between sine
and S&H (Sample and Hold) modulation shapes. The sine option creates
smooth modulations in the form of rounded peaks and valleys, while the
S&H settings generate random positive and negative values for modulation.

There are actually two LFOs - one for each stereo channel. The Phase and
Spin controls define the relation between the two LFOs.

Phase keeps both at the same frequency, but allows you to set the two LFO
waveforms “out of phase” with each other, creating stereo movement. With
a maximum setting, the two LFOs are placed 180 degrees apart, so that
when LFO reaches its peak, the other hits its minimum.

Spin allows you to detune the speeds of the two LFOs from each other.
Each stereo channel is modulated with a different frequency determined by
the spin amount.
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Chorus

Chorus
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The Chorus effect.

The Chorus effect uses two time-modulated delays in series to create cho-
rus and flanging sounds.

Each delay has its own delay time control calibrated in milliseconds. Delay 1
has a high pass filter which can be used to selectively remove low frequen-
cies from the delay signal. Greater high pass values let only very high fre-
quencies pass through to Delay 1.

Delay 2 can be switched between three different modes for a variety of ef-
fects. When switched off only Delay 1 is audible. In “fix" mode, only Delay
1's delay time will be modulated. When “mod” is activated, Delay 2 will re-
ceive the same modulation as Delay 1.

The Modulation XY controller allows you to create sounds with a certain
amount of “motion”. Clicking and dragging along the horizontal axis will
change the frequency of modulation on the delay times. Dragging along the
vertical axis will change the amount of modulation. You can also make
changes by typing in the Amount and Freq fields below the XY controller.
The Amount value is defined in milliseconds of time, while the modulation
frequency is measured in Hertz.

Clicking the *20 switch multiplies the frequency of modulation by 20 to
achieve more extreme sounds.

You can determine how much of the output signal is fed back to the input
with the Feedback control. You can change the polarity of the feedback sig-
nal with the Polarity switch.

The Dry/Wet control allows you to adjust the balance between fully effected
and fully dry signals. Set it to maximum if using the Chorus in a send channel.
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Compressor
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The Compressor effect.
The Compressor is just that: an audio compressor, thus a device that levels

out level peaks in the signal which lets you create higher average levels. The
following table explains the Compressor parameters and how to use them:

Parameter Effect

Ratio This dial lets you determine the degree to which the level of signals
that exceed the Threshold value (discussed below), is reduced.

Threshold This fader lets you set the threshold above which compression sets
in. Signals with levels above the Threshold value are processed,
signals with lower levels aren't.

In the real world this means: The smaller the Threshold value, the
stronger the compression effect.

Attack This dial lets you set the speed with which compression sets in when
the level exceeds the set Threshold value. If you increase this value,
the Compressor will react slower and more signal peaks will pass
through unprocessed.

Release The time value that you set with this dial determines how long it takes
for the Compressor to let the signal pass through unprocessed after
the signal level has fallen beneath the set Threshold value.

Set this parameter to a small value to generate the typical “pumping”
compressor effect. Smoother changes in dynamics are achieved by
setting higher values.

G.R. This display shows the amount of level reduction caused by the
compression effect.
Out This faders is used to set the output level of the effect.
REMIX
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EQ Four

EQ Four
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The EQ Four effect.

The EQ Four effect is an equalizer composed of four parametric filters.
Equalizers are useful for changing the frequency characteristics of a sound.
Filter one can be switched between bell-curve, low-shelf, or low-cut modes.
Filters two and three are always bellcurves. Filter four can be switched be-
tween bell-curve, high-shelf, or high-cut characteristics. Each of the filter
bands can be switched on or off independently.

You can edit the filter curve by clicking and dragging on one of the filter dots
in the XY view. Horizontal movement changes the filter frequency and verti-
cal movement adjusts the gain of the filter band. Holding down the [Alt] key
while moving the mouse allows you to adjust the Q, or resonant bandwidth,
of the filter.

You can also make changes by selecting each filter band with the numbered
filter selector buttons. The filter currently selected can then be adjusted us-
ing the Freq, Gain, and Q dials. You can also type values into the number
fields below each dial. The Gain slider lets you set a global level after filtering.
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Simple Delay

Simple Delay
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The Simple Delay effect.
The Simple Delay offers two delay paths (L+R) with independent feedback.

The Delay Time selector switches let you set a signal delay that depends on
the Master Tempo. The numeric switches represent sixteenth notes; a value
of 4 will therefore generate a quarter note delay. This function must be acti-
vated using the Time/Sync toggle switch. When the toggle switch is set to
“Time", the delay time is shown in milliseconds in the corresponding field.

To input the delay time, you can either click on the field, hold down the
mouse button and drag the mouse or you can double click on the field and
type in a value. When “Sync” is active, you can use the field to input a per-
centage value (which represents a delay time deviation from an even value)
to create a swing feel.

The Feedback parameter lets you set the proportion of the output signal that
is fed back into the input. High values can lead to “infinite” feedback —
please take good care of your ears and speakers!

The Dry/Wet dial is used to add the dry (unprocessed) to the processed
signal. Set this dial to a minimum setting when you use the Simple Delay on
a Send track.
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The Menu Functions

File Menu

New Remix Set
Creates a new REMIX Set.

Open Remix Set

Opens an existing REMIX Set. REMIX Sets can also be located and opened
using the built-in file browsers.

Close Remix Set
Closes a REMIX Set.

Save Remix Set
Saves the current REMIX Set.

Save Remix Set As

Saves the current REMIX Set under a different name and/or directory loca-
tion.

Save a Copy

Saves a copy of the current REMIX Set with a new name and/or new loca-
tion but doesn't replace the current REMIX document. Useful for saving
multiple versions of a Set.

Save As Self Contained

Saves the current REMIX Set under a different name and/or directory loca-
tion. Additionally, REMIX will create, in the selected directory, a subdirectory
(“Name-of-the-Set-Sounds”) and copy all samples that are used by the cur-
rent Set into this subdirectory. All internal file references will be redirected to
the sample copies. Saving as selfcontained makes sure you have all sounds
used by a REMIX Set in one place. This function is very useful for organising
and backing up your work. When you have recorded a new REMIX set, this
can help you with your “housekeeping”. Please see the discussion on

page 20 of the Quick Start Guide to learn more about managing recordings.
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Render to Disk

This option lets you export REMIX's audio output — that is: the sound you
hear via the Master track — as a new audio file. If you wish to export individ-
ual tracks, please deactivate all other tracks by turning off their “Speaker”-

switches in the mixer.

If you call Render to Disk while the Arranger View is up, REMIX renders the selected

time range of the corresponding tracks and saves it as an audio file . If you'd like to
render the current Arrangement loop, choose the Select Loop command from the
Edit menu prior to calling Render to Disk. Keep in mind that the selection of tracks is
irrelevant: the signal to be rendered is the Master output.

If you call Render to Disk while the Session View is up, you must specify the length

of the resulting sample in Bars:Beats:Sixteenths.

In both cases, the Render to Disk dialog appears, in which you can make the

following settings:

Option
Length (Bars/Beats/16th)

Normalize

Render as Loop

File Type

Sample Rate

Create Analysis File

Convert to Mono

OK/Cancel

Purpose

Setting the length of the resulting sample file in bars,
beats and sixteenth notes (only when Session-View is
active).

When switched on, this function optimizes the average
volume level of the resulting sample. To do this, it looks
at the peak levels of the analyzed section.

When switched on, this function creates a sample that
can be used as a loop. This may be important if the
sound uses a reverb or delay effect that would otherwise
be cut off at the end. Here, it is included during a second
calculation process.

Select 16 Bit WAV or AIFF file as file type.

Use this pop-up menu to select the sample rate used to
create the sample. What exactly you can select here
depends on your audio hardware.

If you wish to use the new file in REMIX; this function
should be switched on.

This lets you create a mono instead of a stereo file.

Click OK to confirm your settings and start the rendering
process. Use Cancel to cancel the process.

Quit

Quits the program.
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The Edit Menu

Undo

The last action is removed. The Undo command cannot be used while re-
cording automation. You can, however, undo an entire recording.

Redo

The action that was last undone is redone. The Redo command cannot be
used while recording automation.

Cut

*  Cut removes the selected area from the Arrangement or Session. Cut material is
placed on the clipboard and can be pasted. In the Arranger View, Cut not only re-
moves the clips, but also all automation in the selected time span.

*  Cut Scenes cuts out all scenes with selected slots from the Session View, thereby
reducing the total number of scenes. Please note that the Cut Scenes command af-
fects all tracks, not only those containing selected slots.

Hongkong  Master Hongkong  Master
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G > & E 7
@ [ @ > 8
& > 8 = > 9

The Session View before and after calling the Cut Scenes command.
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Cut Time cuts a selection of time from the Arrangement, thereby moving any audio
on either side of the cut area closer together in the timeline. This command essentially
reduces the length of your Arrangement by whatever amount of time you have cut.
Please note that the Cut time command affects all tracks, not only the selected ones.

1 2 4 | -4

A gap between clips has been deleted by first selecting the time span, then calling
the Delete Time command.
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The Cut Envelope command allows you to cut a selection of automation data from
a track. The selected piece of automation is copied to the clipboard and can be
pasted using the Paste command anywhere in the same track, or in another track.
Within the selected time span, the automation breakpoint envelope turns into a flat
line. The value at the selection start determines the value that will be used throughout
the selected time span.

Occamil

Occamii

Cutting part of an envelope. Notice the clip remains unaffected.

Copy

The Copy command makes a copy of the selected material and places it on the clip-
board. Clips, envelopes and time can all be copied. In the Arranger View, Copy not
only copies the clips, but also all automation in the selected time span.

The Copy Envelope command allows you to copy any section of an automation en-
velope. This command differs from the Copy command in that it only copies the dis-
played envelope, and no clips or other automation.

Paste

The Paste command pastes the material from the clipboard to the selected position.
Material from the clipboard will be pasted into place regardless of the current selec-
tion's size and content. Clips copied from the Arranger View into the Session, and
vice versa, retain their temporal/spatial order.

Paste Time places copied time into the Arrangement, thereby increasing its overall
duration by the length of time you have copied.

Paste Scenes works like Paste, but inserts blank scenes before pasting. Remix in-
serts just enough scenes to fit the material from the clipboard. The new scenes will
be inserted behind the current selection.
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Duplicate

*  The Duplicate command automatically copies and pastes a selection. This is an
easy way to make multiple copies of a clip or selection of clips. In the Session View,
the copies are put into the slots which follow the last selected slots. In the Arranger
View, the copies are put behind the selection, into the “future” of the Arrangement.

Creating repetition with the Duplicate command.

* Duplicate Time places a copy of the selected time span into the Arrangement,
thereby increasing its overall duration by the length of the selection.

*  Duplicate Scenes works like Duplicate, but inserts blank scenes before pasting.
Remix inserts just enough scenes to fit the material from the clipboard.
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The Session View before and after calling the Duplicate Scenes command.
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Duplicate Envelope duplicates the selected portion of an automation envelope
into the Arrangement's “future”. Duplicate Envelope can be used to create repeating
control movements.

Occamil

Occami J

Duplicating part of an envelope. Note that the clip remains unaffected.

Delete

The Delete command erases any selected items. Delete differs from the Cut com-
mand in that deleted items cannot be pasted back (though you can undo any com-
mand at any time).

Delete Scenes deletes all scenes with selected slots from the Session View,
thereby reducing the total number of scenes. Please note that the Delete Scenes
command affects all tracks, not only those containing selected slots.

Delete Time deletes a selection of time from the Arrangement, thereby moving any
audio on either side of the deleted area closer together in the timeline. This com-
mand essentially reduces the length of your Arrangement by whatever amount of
time you have deleted. Please note that the Delete time command affects all tracks,
not only the selected ones.

The Delete Envelope command allows you to delete a selection of automation data
from a track. Within the selected time span, the automation breakpoint envelope
turns into a flat line. The value at the selection start determines the value that will be
used throughout the selected time span.
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Insert

Insert Scene inserts an empty scene behind the current selection.
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The Session View before and after calling the Insert Scene command.

The Insert Silence command inserts as much empty time as currently selected into
the Arrangement, behind the selection.

F—M e
Inserting Silence.
The Insert Track and Insert Send Track commands add more clip tracks and

more send tracks to the Remix Set. You can add an unlimited number of clip tracks
and up to four send tracks to a Remix Set.
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Split

The Split command allows you to quickly cut a clip into smaller pieces. It works by
making a cut at the start and end point of the selection you drag over a clip. Click and
drag a selection over a clip file and choose the Split command. The original clip will
now be divided into three pieces.

I

Using the Split command to split a clip.

Add Slot Button/Remove Slot Button

Depending on what's selected in the Session view, one of these two op-
tions is available on the Edit menu. You can use them to equip one or sev-
eral empty slots with stop buttons or remove them again.

Select

The Loop Selection command turns the Arrangement loop on and sets the loop
markers to match the selected time span.
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*  The Select Loop command automatically selects all Arrangement time within the Ar-
rangement loop markers. This is useful if you have edited together an Arrangement
within the loop markers that you find particularly compelling. You can select it all with
the Select Loop command and then duplicate or copy and paste it.

M

Selecting all material in the Arrangement loop with the Select Loop command.

* Inthe Session view, Select All selects all slots in all tracks. In the Arranger view, Se-
lect All selects the time in all tracks, from the beginning of the first clip to the end of
the last clip. To select not only the Arrangement time which is occupied by clips, but
all time, choose Select All, then Select To, then Select From. This is useful for in-
stance to delete all automation from a Remix Set.
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The View Menu

The following commands open their selected views.

¢ Info

e Arranger
e Session
e Clip

¢ Track

¢ Bus

*  Remix Effects
¢ Plug-In Effects

* Files1
* Files2
¢ Files3

The following commands are used to hide/show mixer components. You
can use different mixer view setups in the Session View and in the Arranger
View.

¢ Overview (cannot be hidden in the Arranger)

* Sends

¢ Mixer

The Options Menu
Edit Key Map

Activates Key Map Mode for assigning ASCII controls. Please see section
“Assigning Key Controllers — Key Map Mode" on page 25 of the Quick Start
Guide for more information regarding ASCII key mapping.

Quantization

Lets you select a quantization rate to be used for launching clips from the
Session View. In other words: By selecting a note value, you determine the
maximum time between the moment when you trigger the clip and the mo-
ment when clip playback actually starts. Playback will thus start when the
following bar, the next halve, quarter, eighth, sixteenth or thirtysecond note
is reached. Quantization can be switched off by selecting None.

Snap to Grid Lines

This option and the following (Snap to Quantization) are never available at
the same time. Instead, you toggle between them by selecting one. The Ar-
ranger view must be active for any of these options to be available.
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If Snap to Grid Lines is selected, the mouse snaps to the displayed ruler
marks. Because the ruler mark spacing adapts to the current zoom factor,
Snap to Grid provides you with a reasonable raster for selection, editing and
marker movements regardless of the zoom setting.

Snap to Quantization

If Snap to Quantization is selected, the mouse uses the global quantization
setting as a raster to snap to the nearest quantization position for selection,
editing, and moving markers. The global quantization can be set using the
Options menu or using the pop-up menu in the Control Bar. If you do not
want to use a raster for editing at all, set the global quantization to None.

Follow

When the Follow command is activated, the Arranger View will scroll dur-
ing playback to constantly show the current position in time. Follow is auto-
matically turned on when you start playing; it is turned off when you scroll,
zoom, or move markers.

Preferences

Brings up the Preferences dialog. Please see the section “Setting Remix
Preferences” on page 35 to learn more about the Preferences.

Help Menu

All functions on this menu except for “Help..."” and “About Remix..." require
that you have connected your computer to a working internet connection
and that you have properly set up your browser software.

Help...

Opens the reference manual in Adobe Acrobat format. This requires that
you have properly installed the Adobe Acrobat Reader program on your
computer.

Home Page...

Starts your web browser and connects you to the Steinberg web site on the
internet.
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Product News...

Starts your web browser and connects you to the Steinberg Product News
page on the internet. You should regularly visit this page to obtain informa-
tion about updates and new products.

Community...

Starts your web browser and connects you to the Steinberg Creative Tools
community web site on the internet.

Support...

Starts your web browser and connects you to the Steinberg Knowledgebase.
This data base is one of the most frequently used sources of information for
users of Steinberg products. It is packed with a multitude of analysis and so-
lutions to your individual problems. And: you can use it 24 hours a day!

Support Forum...

Starts your web browser and connects you to the Steinberg Tech Support
forums on the internet, which are free of charge and supervised by support
experts. Here you can get technical support directly from Steinberg!
Downloads...

Starts your web browser and connects you to the download area on the
Steinberg web site. New versions of the software may be available for
download here.

Online Shop...

Starts your web browser and connects you to the Steinberg Online Shop.

About Remix...

This opens a dialog with information about people who contributed to the
development of this product.
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REMIX Key Commands

File Menu
Function Simultaneously press... and. and...
New REMIX Set [Cirl] N
Open REMIX Set... [Cirl] (0]
Close REMIX Set [Ctrl] W
Save REMIX Set [Ctrl] S
Save REMIX Set As... [Ctrl] S [Shift]
Render to Disk... [Ctrl] R
Quit [Ctrl] Q
Edit Menu
Function Simultaneously press... and. and...
Undo [Citrl] z
Redo [Ctrl] Y
Cut [Ctrl] X
Cut Time/Scenes [Ctrl] X
Cut Envelope [Ctrl] X [Alt]/[Option]
Copy [Ctrl] (e}
Copy Envelope [Ctrl] C [Alt]/[Option]
Paste [Ctrl] \
Paste Time/Scenes [Ctrl] )
Duplicate [Ctrl] D
Duplicate Time/Scenes [Cirl] D
Duplicate Envelope [Cirl] D [Alt]/[Option]
Dolete Del/Backspace
Delete Time Del/Backspace [Ctrl] [Shift]
Delete Scenes Del/Backspace [Ctrl] [Shift]
Insert Time [Ctrl] |
Insert Scenes [Ctrl] |
Insert Track [Ctrl] T
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Function Simultaneously press... and... and...

Insert Send Track [Cirl] T [Alt]/[Option]

Split [Citrl]

Add/Remove Slot [Ctrl]

Button

Loop Selection [Ctrl] L

Select Loop [Ctrl] [Shift]

Select All [Ctrl] A
View Menu

Function Simultaneously press... and... and...

Info ?

Overview [Ctrl] [Alt]/[Option]

Sends [Ctrl] S [Alt]/[Option]

Mixer [Citrl] [Alt]/[Option]
Options Menu

Function Simultaneously press... and...

Edit Key Map [Ctrl] K

One Bar Quantization [Ctrl] 1

Half Note Quantization [Ctrl] 2

Quarter Note Quantization [Ctrl] 3

Eigth Note Quantization [Ctrl] 4

Sixteenth Quantization [Ctrl] 5

Thirty-Second-Note Quantization  [Ctrl] 6

No Quantisation [Ctrl] 0

Snap to Grid/Snap to Quantization [Ctr] G

Follow [Ctrl] F
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Navigation

Function Simultaneously press... and... and...
Jump to neighbouring area Arrow keys [Alt]/[Option]
Jump to neighbouring control  Arrow keys [Ctrl]
Toggle Session/Arranger Tab
Toggle Browsers F11
Hide/Show Browser Area F11 [Shift]
Toggle Detail Area F12
Hide/Show Detail Area F12 [Shift]
Controls
Function Simultaneously press... and... and...
Increment/Decrement Arrow keys
Increment/Decrement (Large  Page Up/Dn
Steps)
Go Default Del/Backspace
Delete Automation Del/Backspace [Ctrl] [Alt]/[Option]
Type in numerical 0.9

Transport
Function Simultaneously press... and...
Play/Stop Space
Record Fo
Clips/Mixer
Function Press...
Launch selected Clip Return
Unmute/Mute Track 1..8 F1...F8
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Clips View Sample Display

Function Simultaneously press... and...
Move selected Warp Marker Arrow left/right

Select Warp Marker Arrow left/right [Ctrl]
Move Loop by Loop Length Arrow up/down
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Index

A
AIFF
Standard Macintosh
audio format 36
Arrangement
Editing 13
Overview 8, 14
Auto Filter 41

(o

Choose Language
Language 37

Chorus 43

Clip
Changing the length 19

Clip Pool 9

Clip Update Rate 36

Clip View 22

Clips
Horizontal insertion 9
Loading 32
Playback choices 23
Playback of single 10
Selecting 17
Vertical insertion 9

Compressor 44

Control Bar 5

D

Delete 8

Detune control 25

E

Edit button 24

Editing, Arrangement 13

Effects
Auto Filter 41
Chorus 43
Compressor 44
EQ Four 45
Inserting 21
Simple Delay 46

Effects Browsers 33

EQ Four 45

F

Fade switch 25

Fast forward 6

Feedback
Effects 11

File Browsers 31

G

Gain control 25

H

Hi-Q switch 25

1

Insert Clip Track 8
Insert effects 21
Insert Send Track 8

L
Launch Mode 23, 37
Loading
Clips 32
Samples 32
Sets 32
Loop 37
End 26
Length 26
Offset 26
Setting the 28
Start 26
Loop marker 28
Loop markers 14
Loop parameters 6
M
Mixer controls
Hiding/showing 12
N
Navigating
The directory hierarchy 32
(o]
Offset
Setting the 28
Original BPM 26
Overview 8, 14
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P
Pan 12

Paths 38

Pre/Post switch 11

Q

Quantization 6, 23, 28, 37
R

Record File Type 36

Repl button 25
Resampling 12

Rewind 6

Rulers 15

S
Sample Display 27
Sample Settings 24
Samples
Create Analysis File 36
Loading 32
Save button 25
Scene
Starting a 9
Select on Launch 36
Selection rectangle 9, 31
Send controls 11
Sets
Loading 32
Simple Delay 46
Skin
Load 36
Snap to Grid 28
Snap to Grid Lines 18
Snap to Quantization 18, 28, 29
Solo function 12
Start markers 14
Start offset marker 28
System Monitor
CPU load indication 7
T
Tempo 5
Time
Selecting 17
Time signature 5
Time warping 26
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Track Display 16
Track headers 8
Track Height 37
Track View
Inserting effects 21
Tracks
Mute/Unmute 12
Re-ordering 8
Status fields 10
Transport controls 5
Transpose control 25
Triggering
Quantization 6
U
Use Global Quantization 6

\")
Views
Clip View 22
Volume control 12
VST plug-ins
Using 33
w
Warp settings 26
WAV

Standard PC audio format 36
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